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1 Netop Asset Control overview

Netop Asset Control collects information about hardware and software on your company
network and provides comprehensive overviews of computers, printers and applications.

All details are presented in a central manager module that allows the IT administrator to
filter, sort and group information according to his needs.

Advanced custom filtering mechanisms allow you to view exactly the computers that are
relevant in a certain context, for example computers acquired within the last year or
computers that match the Microsoft Vista operating system requirements. 

Applications on networked Microsoft Windows computers are automatically analyzed and
registered with information about publisher, version and installation path. The automatic
product recognition is close to 100% and should an application not be recognized as such,
information can be added manually. Four different categories for products support a
company workflow where the IT administrator reviews and approves the applications that
have been found automatically for use in a business environment. 

Data about installed applications are tied together with information about the licenses
that the company has acquired which makes the IT administrator able to document
license compliance.

Using Netop Asset Control you can:

· Keep track of installed applications.

· Monitor use of applications.
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· Maintain an inventory of software licenses.

· Create reports.

· Use custom data to track or organize computers.

· Identify printers on your network.

· Scan the entire network automatically.

· Create custom scan settings to scan clients at predefined intervals.

· Generate inventory of all hardware components, including details about system BIOS,
RAM, hard disk size and free space, graphics card, serial numbers, printers and more.

· Perform remote scanning, defined by IP ranges and performed without noticeable
performance costs to the clients scanned and without leaving software on the scanned
clients.

If the IT environment where Netop Asset Control is installed also uses other Netop
products, the shortcut menu from Netop Asset Control computer overview offers easy
access to Netop Remote Control, Netop Remote Management and Netop File
Manager.
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2 Netop Asset Control components

These are the components of a complete Netop Asset Control installation:

Netop Asset
Agent

Netop Asset Agent is installed on all PCs and servers to be scanned
regularly. 

Note

Netop Asset Agent does not necessarily have to be installed on a
computer for it to be included in an instant scan: a remote scan of a
single computer based on computer name or of computers within an
IP range can be initiated and run from the Manager without installing
any software; refer to the Netop Asset Manager Help for details.

Netop Asset Agent can also be activated from a logon script and thus
activated when a computer starts up.

The Agent runs as a service and users will not see the Agent nor
experience any performance load on their computers.

Each Agent delivers scan data to the scan data folder on the data
share. The scan data is subsequently imported from the data share to
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the central data storage, the SQL Server.

Agents read their configuration settings like for example scan
frequency, from the data share.

SQL Server
and
data share

The SQL Server is the central storage area and is where the Netop
Asset Control database is installed.

The data share is a simple folder structure that contains the collected
data from all Agents. In addition to the scan data, the data share
also stores Agent configuration settings and log files.

The data share folder also contains the following Netop Asset Control
components:

· Netop Asset Engine - service that controls various jobs including
Import and Sync.

· Netop Asset Import - manages data import to the database on the
SQL Server. 

· Netop Asset Sync - handles the synchronization between the SQL
Server and the Active Directory Server.

The data share must be located on the same server as the SQL
Server.

Netop Asset
Manager

Netop Asset Manager is the interface to data collected by the
Agents.

The Manager imports the scan data from the Netop Asset Control
database on the SQL Server and presents data about hardware and
software. 

The Manager is also the interface to configuring how the Agents
work: scan frequency and other Agent settings are defined from the
Manager, saved in the configuration folder and refreshed at a
configurable interval.

Active
Directory
Server

An Active Directory (AD) Server is not required for running Netop
Asset Control but if Active Directory has already been implemented
and is operational on one or more servers in the company, Netop
Asset Control can use the Active Directory information and offer, for
example, data filtering on organizational unit.
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3 Install Netop Asset Control

Installing Netop Asset Control is a simple process: on the computer you want to use as
Netop Asset Manager, you start the installation program and follow the wizard page
instructions. The only choices to make are program folders and whether the program is to
be used by you only or by other users as well.

When the installation is complete, you start the Netop Asset Manager from Windows' 
Start menu. When Netop Asset Manager opens, a wizard to install the other Netop Asset
Control components and to make the required setup automatically starts up. This wizard
handles the installation of server components and database and ensures that the Netop
Asset Manager is set up to use the newly installed database.

The Netop Asset Agent is a very small (less than 300 KB) program that you distribute to
the computers to be included in regular scans. The agent can be distributed to the client
computers in a logon script or any other way that you normally distribute software or
updates on the company network. Once distributed, the Netop Asset Agent is installed
and runs as a service, completely transparent for the computer user.

For installation details, refer to Netop Asset Control Installation Guide.
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4 Use Netop Asset Control

The following sections give an introduction to the main tasks that Netop Asset Control
can help you perform:

Configure Netop Asset Control to
meet company requirements

When the installation is complete, Netop Asset
Control is operational and the data collection from
the client computers begins. However, the default
settings can be changed to suit company needs and
requirements, for example with respect to scan
frequency and historical data storage.

Get an overview of computers and
printers

The comprehensive overview of computers gives
easy access to filtering and sorting to provide an
overview of exactly the information the IT
administrator needs. For each computer, you can
drill down and see all details about hardware
components and installed software.

The printer overview lists network printers as well a
local printers.

Get an overview of installed
software

Almost 100% of software products on client
computers will be recognized as such and presented
in the products overview. The IT administrator can
review the list for non-business related products or
products that require no license. 

Manage software licenses The list of products is an interpretation of the data
found on computers where the Agent is performing
its scan. The licenses on the other hand come from
a database of all licenses that have been acquired
by the company. When the two sets of information
are tied together, license compliance can be verified
and documented. This tying together is done as part
of creating a license.

Counting licenses can be done in a number of
different ways; five of them are available out of the
box and additional methods can be defined.

Document hardware and software
usage by creating reports

A number of standard reports are included as
samples of the reports that can be created. The
reports can be generated from Netop Asset Manager
or made accessible on a Web site also to users who
do not use Netop Asset Control.

You can define your own dynamic reports related to
hardware and operating systems; these reports can
be based on many different criteria, like for example
operating system, hotfix, computer type, RAM and
free disk space.

If you want to learn details about each task and about how to use Netop Asset Control,
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refer to Netop Asset Control User's Guide and to the assistance available from the
product Help menu.

4.1 Configure Netop Asset Control

Among the parameters you will likely want to review are the settings for the agent
component that scans client computers.

· On the Tools menu, click Options and then click Scan agent.

You can define the types of files to be included
as part of the products scan; default is to scan
for .exe files. To optimize the scan, you can
choose to exclude certain folders, like for
example the recycle bin or the folder where the
operating system is installed, or to exclude
certain file types from the scan.

How often the Agents on the client computers should run and deliver their results to be
presented in the Manager is also configurable.

· On the Tools menu, click Options and then click Intervals.

The scan frequency can be in minutes, hours or
days. Typically computers are scanned on a
daily basis.

Counting product installations

One of the other parameters that you will want to review but not necessarily change are
the ways that Netop Asset Control counts product installations. The way a product is
licensed will typically vary for each license agreement and product count needs to be in
accordance with the license terms. Netop Asset Control can examine all computers
running a Microsoft Windows operating system, including servers and laptops. 

How many times any given product is installed can be counted in one of the following
ways:
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Per computer The total number of product installations on all computers.

Per Windows installation The total number of product installations on all computers but
if one computer has multiple Windows installations and
products installed on each installation, the product is counted
multiple times.

Per user The total number of product installations but if multiple
computers have the same user, multiple product installations
count as one installation.

Concurrent usage The total number of product installations that are used
simultaneously. This is to allow for products that can be
installed any number of time but only have X number of
concurrent usages.

Concurrent usage per
Windows installation

The total number of product installations that are used
simultaneously per Windows installation.

One of these five product count methods must be selected for each license created in
Netop Asset Control. If the terms in a license agreement differ from what can be covered
with the five count methods, a new license type can be defined. This could for example
be a license type that is based on an existing license type, Per Windows installation,
but excludes computers that belong to employees in the QA department. This would cover
the situation when a license agreement stipulates that installations not used for business
purposes do not require a license.

A new license type is defined from the dialog box that lists the built in types:

1.On the Tools menu, click Options and then click License types.

2. In the Options dialog box, click the Add button.

3. Type an appropriate name and a description, select the basic count method and the
filter that selects all employees in the QA department. 

A collection is custom filter. Custom filters can be
defined to filter data across hardware, software and
printer information, for example:

For details about configuration options, refer to the section entitled "Configuring Netop
Asset Manager" in the Netop Asset Control User's Guide.
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4.2 Overview of computers and printers

Use the Computers node to choose how to view the computers on the network. The
standard filters let you view computers organized by Organizational Unit in Active
Directory, by computer manufacturer, by IP addresses, or by custom data fields.

· Right-click the Computers node, and then click the appropriate filter criterion: 

The presentation is based on information in the SQL database. For filtering by 
Organizational Unit in AD (OU), the SQL database synchronizes with the Active
Directory at a configurable frequency.

Sorting computer overview information

The computer overview information can be sorted, the column sequence can be changed
and the information details can be modified. 
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1.On the View menu, click Show columns.

2. In the Select Details dialog box, select the details to
show from the list.

Use the Move up and Move down buttons to change the
column sequence, and the width field to determine column
width.

Alternatively, column sequence, column width and sort
sequence can be changed by manipulating the column
heading in the overview window.

 View detailed information about each computer

· To view all details about one computer, right-click the relevant row and click Details.

Create and use collections

A collection is a custom filter that can be used when you want to view exactly the
computers relevant in a certain context. This could for example be:

· Computers belonging to employees in the QA department.

· Computer belonging to employees who have left the company.

· Computers acquired within the last year.

· Computers with less than 512 MB RAM.

· Computers that match the Microsoft Vista operating system requirements.
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· Computers that are older than two years.

Collections are used to filter the total list of computers, as the basis for reports, and for
defining license count principles.

When a collection has been defined, it can be used as a building block when creating new
collections. For example, the collections

· Computers with CPU speed (MHz) less than 2.00 GHz and less than 512 MB RAM

· Computers running operating system Windows XP and computer name starts with "DEV"

could be combined to figure out whether the development department (assuming that
their computers are named consistently, starting with the same letter combination) have
slow computers running Windows XP.

Overview of all printers on the network

Click the Printers node to get an overview of all printers on the network.

Printer information is based on the printer drivers that are installed on the computers:
Netop Asset Control deduces make and model of the physical device based on the printer
drivers installed. When different drivers are used for the same physical device, the driver
that is used the most frequently determines the make and model.

A printer is uniquely identified by its host and port combination.
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4.3 Overview of installed software

Click the Products node for a list of the installed software products that the scan
process has found on client computers.

Netop Asset Control scans for software information on client computers, interprets the
information and lists the products that have been identified. The first scan lists all
products and when subsequent scans find additional installations of existing products, the
product count is updated. When a scan finds new products, the product is added to the
list and the counter updated.

Approve products

New products initially have the status Ready for approval. This indicates that a product
has been recognized and that no action has yet been taken as to whether the product is
on the list of products approved and used by the company. For each product the system
administrator or the IT person responsible for product licenses reviews and evaluates
whether the product is among the ones that the company has a license to install and use.
The next step is to review the list of products in the Ready for approval list and mark
them as approved or not approved:

· Select one or more products in the Ready for approval list, right-click and under
Status select Approved or Not approved.

When a product has been approved, it remains in the Approved list and the product
count is just increased if additional installations are found later.
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Depending on the nature of the software product and the licensing requirements,
products may also be placed in the Approved (no license needed) list rather than the
Approved list. Products in the Approved (no license needed) list are typically freeware
products where a license is not required, like for example Messenger, Skype or Acrobat
Reader.

If the company does not have a license for a product, the system administrator sets the
status to Not approved. Additionally the system administrator will likely take action and
figure out whether use of the product is in the interest of the company and acquire a
license to be able to approve the product. Alternatively, the system administrator might
use the Computers list to identify the computers and users using the products and ask
them to remove the non-approved software.

Generally the Not approved list will require some sort of follow-up. 

4.4 Managing licenses

Click the License management node for a complete list of licenses, regardless of the
agreement they were acquired under.

The Manufacturers, Suppliers and
Agreements nodes constitute a non-
hierarchical database. The nodes offer
alternative views of licenses: for example,
expanding the nodes beneath Suppliers,
displays a list of licenses from the selected
supplier only.

Sorting license overview information

Like the computer overview information, the license information can be sorted, the column
sequence can be changed and the information details can be modified. 

1.On the View menu, click Show columns.

2. In the Select Details dialog box, select the details to
show from the list.

Use the Move up and Move down buttons to change the
column sequence, and the width field to determine column
width.

Alternatively, column sequence, column width and sort
sequence can be changed by manipulating manipulating
the column heading in the overview window.

Create a new license

Each license has a name and a set of properties like for example number of licenses, price,
purchase date and expiration date.

Creating new licenses is most conveniently done when at least one scan of client
computers has been executed. Among other things, scanning client computers builds up
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the list of scanned products and this list can be used to associate the license with a
scanned product.

Also, an agreement is a prerequisite for creating a license: Any license must be created
on the basis of an existing agreement and one or more licenses can be based on the same
agreement. 

An agreement always includes this information:

· The software development company that created the product: the manufacturer - for
example Microsoft Corporation.

· The software distributing company that sold the product: the supplier - for example
buycheapsoftware.com

To create a new license: 

1. Right-click the License management node and then click New license.

2.On the General tab, select an agreement, type a suitable name for the license,
specify how many licenses are covered, and select a purchase date.

The other fields on the General tab are optional and whether they are used typically
differ in different companies.

3.On the Licensed products tab, select the product that the license was purchased
for.

4.On the License count tab, select a license type to specify how licenses are
counted. As mentioned in the Configure Netop Asset Control section, five built-in
count methods are available and additional license count methods can be defined.
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4.5 Reporting

Netop Asset Control includes a number of standard reports as samples of the reports that
can be created.

Software not used A list of software products that have been installed but are not
used (= have not been started). The list includes information
about software version and the names of the computers where
the software is installed.

License compliance A list of the licenses that exist in the system and for each
license:

· The number of purchased licenses.

· The number of actual product installations.

· The number of licenses that can still be used for product
installations. This number can be negative to indicate that
more products installations have been made than the number
of licenses warrants.

· The date when the client computers were last scanned and the
actual product installations number updated.

Hardware inventory A list of computers with details about each:

· Computer name.

· The user who last logged on.

· Universally Unique Identifier (A 128-bit number used to uniquely

identify the computer) (UUID) for the computer.

· Basic Input Operating System (BIOS) version.

· Central Processing Unit (CPU) details.

· CPU speed.

· Memory size in MB.

· Number of unused memory slots.

· Type of network card.

· Type of graphics card.

· Hard disk size in bytes.

· Computer serial number.

· Monitor serial number.

· Operating system (OS).

By default these reports are based on all currently available data. To filter on the data
that the report is based on, create a suitable collection to identify the relevant
computers and select that collection when generating a report.

Examples

· A hardware inventory report listed by department might be useful in situations when
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hardware updates are panned. In this scenario a collection filtering on department could
be useful.

· In a company with multiple geographical locations, a report listing software not used in
each location might be relevant. In this scenario a collection filtering on cost center or
department - depending on the organization - could be used.

Also by default, the date used for a report is up to and including today's date. To select a
different date interval, select a start date and end date. Filtering on date intervals could
for example be relevant in an analysis of hardware and software purchase patterns, to
cover a fiscal year, or to document license compliance in a specific period.

Ways to publish a report

The reports can be generated, viewed and saved in Netop Asset Manager. Available
output formats include pdf, xls and csv. 

For users, for example the CFO or the Finance Manager, who do not use Netop Asset
Control in their daily work but who have an interest in viewing the data collected by
Netop Asset Control, reports can be generated on-the-fly and published on a company
intranet site. This is achieved by posting a link to the  server where the reports are
generated and saved.

Create your own reports

Using collections almost any data can be extracted from Netop Asset Control, exported to
.csv format and presented in, for example, Excel. Collections work much like advanced
filters in the sense that when a collection has been defined, it can be used as a building
block when creating new collections.

The collections included in Netop Asset Control are examples of some of the reports you
can create using collections, for example:

· Computers that have movie files or music files taking up more than X MB on the hard
disk.

· Computers that cannot be upgraded to Windows Vista.

· Computers with a slow CPU and little RAM.

· Computers belonging to employees in a specific department.

The collections are defined by selecting one of more criteria from a list and choosing
whether one or all of the criteria should be met.
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